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Abstract:
Weights are essential to the correct analysis of almost every NCES data file. This short course will explain a little of the why and a lot of the how with regards to the use of weights with publicly available education data. Particular attention will be paid to the National Household Education Survey (NHES) and examples will be presented using a variety of software, including both popular commercial software and freeware.
Introduction: 
A simple example of weights:
Weights are generated to compensate for different response rates for different groups when it is known (or suspected) that members of different groups respond similarly to other members of the group, but differently from members of other groups.

If gender, for instance, is considered a potential source of bias, the researcher may use gender as a weight generating factor.

For example, if we know that the male/female breakdown for the population is 50/50 and the sample we collect has response rates of 83% for males and 75% for females, then sample weights could be calculated as:

1/.83 = 1.204819 
and 
1/.75 = 1.333333 

So for a population of 10,000 people, we may assume that the population actually includes approximately 5,000 males and 5,000 females.

If, for our sample, we get 4,150 males and 3,750 females, adjust these using the weights to get
4150*1.204819 = 4999.999
3750*1.333333 = 4999.999


Weights are always created as multiplicative factors so they can be used with other factors in a larger weighting scheme.

Consequences of Ignoring Weights
A simple grade prediction model will demonstrate that differences may be observed when probabilistically sampled data are analyzed in three different ways. As a foil to this demonstration, an ordinary least squares regression model will be created and used to predict students’ grades using independent variables for race, income and television. 
The model used to illustrate the impact of weights is: 
Grades = Race, Income, TV
In the first analysis, no weights will be used. In the second analysis, the only Final Child weight will be used. In the third analysis, both the Final Child weight and the replicate weights will be used (this is the correct analysis).  AM Statistical Software performs the analyses using ordinary least squares regression for the first two analyses and a Jackknife method for the last, replicated regression analysis. AM Statistical Software Beta Version 0.06.03. (c) was developed by The American Institutes for Research (A.I.R.) and Jon Cohen.


[bookmark: _GoBack]The Data
The analyses use data from the National Household Education Surveys Program of 2007, Parent and Family Involvement in Education Survey (PFI-NHES:2007).
The model Grades = Race, Income, TV will be specified using the following variables:

1. SEGRADES: Overall, what are the child’s grades across all subjects?

Response	Value
	Mostly A’s	1
	Mostly B’s	2
	Mostly C’s	3
	Mostly D’s	4

2. CBLACK – Is the child Black or African American?

Response	Value
	Yes		1
	No		2

3. TVWKDYNU – How much time does the child spend watching television or videos on a typical weekday? 

Response	Value
	1-16		1-16

4. HINCOME – What is the total household income?

Response		Value
$5,000 or less		1
$5,001-$10,000		2
$10,001-$15,000	3
$15,001-$20,000	4
$20,001-$25,000	5
$25,001-$30,000	6
$30,001-$35,000	7
$35,001-$40,000	8
$40,001-$45,000	9
$45,001-$50,000	10
$50,001-$60,000	11
$60,001-$75,000	12
$75,001-$100,000	13
Over $100,000		14

Note: the following results are generated solely for the purpose of demonstrating the differences observed when data of this type are analyzed in different ways. The reader should attempt no further interpretation of the models presented here as none of the underlying assumptions of the models has been checked.

The AM output for the three analyses is:

Model: SEGRADES = CBLACK HINCOME TVWKDYNU

Regression: No Weights

Parameter	Estimate	SE	t	p > |t|	
Constant	2.860		0.081	35.120	0.000	
CBLACK 	-0.078		0.042	-1.879	0.060	
HINCOME 	-0.022		0.004	-5.436	0.000	
TVWKDYNU	0.428		0.018	23.608	0.000	

Regression: Final Weight Only

Parameter	Estimate	SE	t	p > |t|
Constant	2.913		0.118	24.611	0.000
CBLACK		-0.051		0.059	-0.863	0.388
HINCOME	-0.033		0.006	-5.942	0.000
TVWKDYNU	0.394		0.024	16.154	0.000

Replicated Regression: All Weights
	
Parameter	Estimate	SE	t	p > |t|
Constant	2.913		0.130	22.434	0.000
CBLACK		-0.051		0.063	-0.807	0.422
HINCOME	-0.033		0.005	-6.324	0.000
TVWKDYNU	0.394		0.023	16.922	0.000

AM Statistical Software Beta Version 0.06.03. (c) The American Institutes for Research and Jon Cohen


For simplicity, define the three weighting levels as:
Level 1 – No weights are used.
Level 2 – Only Final Weight is used.
Level 3 – Both Final Weight and Replicate Weights are used.

The value in the table below represents the weighting levels that produce a change when moving from the previous level. For instance, a value of “2” indicates that a change is noted when the method of analysis moves from level 1 (no weights) to level 2 (final weight only). A value of “2, 3” indicates a change for that statistics when moving among all 3 levels of weighting.
Parameter	Estimate	SE	t	p > |t|
Constant	2		2, 3	2, 3	2, 3
CBLACK	2	2		2, 3	2, 3	2, 3
HINCOME	2		2, 3	2, 3	2, 3
TVWKDYNU	2		2, 3	2, 3	2, 3

Summarizing, as we move from the use of no weights to the use of only the final weight to the use of both the final weight and the replicate weights (the correct analysis), the regression coefficients change with the use of the final weight, but remain the same when the replicate weights are used. This demonstrates that parameter estimates can be correctly calculated using only the final weight. The final weight alone does not, however, allow for the correct calculation of the standard error necessary for inference. This requires some form of variance estimation such as replication.
Using Data from Complex Samples
The first task with any database is to determine if weights are needed in the analysis. If weights are required, we must then determine what type of weights are involved. If the only weights required are cell weights (aka “final weight,” “child weight,” “household weight,” “hospital weight,” etc.) then the analysis can be done in SPSS or any other standard statistical package that allows weights. If, in addition to the final weight, the sample requires replicate weights (which, in my experience, are always called “replicate weights”) specialized software such as SAS, Wesvar, AM, or Stata must be used. 


An Example of Data Analysis using NHES data.
Before you begin: 
1) Create a folder named “datafiles” on your “C:\” drive.
[image: ]
2) Download the AM Statistical Software
To Download the AM Software:
Point your browser to http://am.air.org/
1) Complete the registration
2) Click on “Download”
3) Login with your newly created password
4) Download the “AM Software Version: 0.06.04 Beta”
5) Download the “AM’s transfer component”
[image: ] 
Once these preliminary tasks are complete, we can begin the process of correctly analyzing the data.
The Big Steps
1) Download the data file
2) Bring the data into SPSS for cleaning
3) Move the data to AM
4) Perform the correct analysis
Downloading the Data
1) To download this (and much more) data, point your web browser to: http://nces.ed.gov/ 
For our purposes today, hover over “Surveys and Programs” and then choose National Household Educational Survey (NHES). 

[image: ]

2) Now choose “NHES:2007 data now available.” This will take you to the download page for not only the 2007 data, but also earlier surveys as well. 
[image: ]
3) We will use the Parent and Family Involvement in Education (PFI) file. Click on the “PFI data” link and agree to the terms of service. The folder will now download.
[image: ]

4) Open the newly downloaded folder and move the file to the “C:\datafiles” folder you created earlier. 
[image: ]
[image: ]
Bring the data into SPSS
5) Open SPSS and click “Cancel” on the first screen that appears.
[image: ]

6) Now, back at the web browser, click on the SPSS setup file.
[image: ]

When the screen below appears:
7) Click in it (to activate it) 
8) “Select all” using Ctrl-A
9) Copy the entire document using Ctrl-C
[image: ]
10) Activate the SPSS window by clicking in it.
[image: ]


11) Paste this text into a new syntax file.
12) Scroll to the top of the SPSS screen (where you just pasted the syntax code) and change the “D:\” to “C:\”
[image: ]
[image: ]
13) Now that you have created the syntax file, the next step is to run it. To do this, click anywhere in the syntax file and then “select all” by pressing Ctrl-A. This will highlight the entire syntax window (shown below).  Now click on the green arrow to run the program. 
[image: ] 


14) The program will run for a few seconds. The SPSS spreadsheet should now be filled with data.
[image: ]  
15)  The next step is to clean the data of missing value codes which will otherwise masquerade as response data. In order to do this we must refer to the codebook. The codebook is located on the same web page as the data downloads and SPSS Setup files. Scroll down to the User’s Manual section and click on PFI Codebook.
[image: ]

16) This will open a searchable .pdf file. To open the search window, click in the codebook window to activate it and then press Ctrl-F. When the search window appears, enter the first variable we want to investigate, “SEGRADES.” Press enter to search for the variable. 
 [image: ]   
The codebook for SEGRADES reveals that only codes 1 through 4 actually indicate the students’ grades. Codes “5” and “-1” indicate that either the child’s school does not give these letter grades or the data value is missing. In either case, we do not want the values “5” nor “-1” to be included in our analysis. 
Continue to search the codebook for the rest of the variables that will be used in the analysis and note the values of each variable that need to be deleted. Note that you need to scroll to the top of the codebook for each search. This ensures that the entire document is searched. It is also helpful to sometimes search for only part of the variable name. For instance, better results may be found using the search term “grades,” rather than “segrades.”



17) To delete the unwanted values using SPSS, choose “Select Cases” under the “Data” menu.
[image: ]



18) Choose “If condition is satisfied” and then click on the blue “If…” button.

[image: ]



19) Type in the if condition based on the values you chose to delete for each variable. For our example we want to delete data for which SEGRADES = 5, SEGRADES = -1, and TVWKDYNU = -1.
20) Click “Continue.”

[image: ]



21) Choose “Copy selected cases to a new dataset” and name the new dataset “NoMissings.”
22) Click “OK.”
 
[image: ]



23)  Under the “File” menu, choose “Save As” and save the new dataset to the “datafiles” folder you created earlier. Close the SPSS windows. This will exit SPSS.  

[image: ]




24) Open the AM software by double clicking on it (the icon may be named “AMbeta”).
25) Now choose “File, Import, SPSS.sav file.”
26) Locate the “NoMissings” dataset and open it using AM.
[image: ]

27) Your screen should look like this:
[image: ]
For the purposes of this demonstration we want to create a regression model that predicts grades using race and television. Specifically, the model we will create will be:
SEGRADES=CBLACK, HINCOME, TVWKDYNU
The data are the result of a complex sample. Thus, we must determine the weights to be used in the correct analysis. In this case, both the final child weight and the replicate weights must be used. In general, the following search terms will produce results: “JK,” “BRR,” “Fay,” and “Taylor,” and of course, “weights.”
28) Search the User’s Manual, Volume 1
[image: ]



29) Click in the User’s Manual window to activate it. Press Ctrl-F to search the document. A search of the term “JK” finds the following paragraph which tells us that the replication method should be specified as “JK1.” Hold on to that information, we will use it a bit later.
[image: ]
30) Since the data uses replication weights, we will need to use replication methods for our analysis. Back in the AM software, choose Statistics, Replication Procedures for Basic Statistics, Regression.

[image: ]
31)  To specify the model, first search for each variable using the search window at the bottom of the screen. Once the variable is located, right click on it and drag the variable from the variable list to the appropriate box. Once the model variables are all in their places, drag the weights to their boxes. Note: in most databases, the weights are at the end of the variable list. It is easier to simply scroll down to weights and drag them over rather than searching for them individually.
32) Choose the “JK1” option for the Replication Method.
33) Choose Plain Text Output or Spreadsheet Output for the output options. Note: both of these options suffer from formatting issues, but the spreadsheet option suffers much less than the plain text option.
34) Click “OK”
[image: ]  

35) OUTPUT!
 [image: ]
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A total of 80 replicates were defined for NHES:2007 based on the sampling of telephone
numberk. This number was chosen to provide reliable estimates of sampling errors with reasonable data
processing costs. The specific replication procedure used for NHES:2007 was a jackknife replication
method (Wolter 1985). It involved dividing the sample info 80 random subsamples (replicates) for the
computation of the replicate weights. Replicate weights were created for cach of the 80 replicates using
the same estimation procedures that were used for the full sample. These replicate weights are included
in the SR file as FRWT1 through FRWTS0, and in the PFI file as FPWTI through FPWTS0. The
computation of the sampling errors using these replicate weights can be done casily using the Windows-
based software packages WesVar Complex Samples Software, SUDAAN (Shah et al. 1995), Stata, or AM
Statistical Software; in WesVar or SUDAAN, the replication method should be specified as JK1. The
current version of WesVar Complex Samples (version 5) is available from Westat. Information can be
obtained at htp://www westat.com/wesvar. A previous version of WesVar (version 4) is available free of
charge at that Web site or by sending an e-mail message fo wesvar@westatcom. Information on
obtaining SUDAAN can be found at hitp://www sti.org/sudaan, and the AM software is available at
hitp://am air.org. Information on Stata can be found at htp://www stata.com.




image27.png
¥ M

Bin Malu
Ani-Mahy

@ o 3 Untited - AM
Michfeel  Chrs, File View Dota [SEStisfics) Graphics Results Help 5| Pt
SecySe st Vet s || e s T a2
= Nare MML Proceduresfor Test Data > Descriptive
o | tictnitic | | commions oo
S ENGLSPAN hg_ Pveo2
gAEEZDDS Procedures Under Development » |l Regression s 2012
SEx
alyss » o
. - IRT/Test Analys Probit
SGRESPSEX  PARENT RESPONDENTS SEX USER OrderedProbit \
SERESRELN  PARENT RIS RELATIONSHITOC..  USER Logit s
SEMOMAGED  MOMS AGE -1 user Molinomil Logt (generalized) | G
SGMOMTYPE!  SPECIFICRELAT OF MOM TO CHIL..  USER 3
YEMOMAGE2  MOMS AGE -2 USER Mantel-Haenszel Chi-Square: "
SGMOMTYPE2  SPECIFICRELAT OF MOM TO CHIL..  USER
SGDADAGET  DADSAGE-1 usER fall 8
SEDADTYPE!  SPECIICRELAT OF FATHER TOC.. USER P
SGDADARE2  DADSAGE-2 usER et
SGDADTYPE2  SPECIFICRELAT OF FATHER TOC.. USER % =
SgAGE! Q/HH MEM - #1'5 AGE usER % O
Hpsext O/HH MEM - #1' SEX usER d Model Run| Title k
SGRELATNT  O/MH MEM - #1S RELATIONTOC..  USER %
g ane2 Q/HH MEM - 25 AGE usER % ety
Tgsee Q/HH MEM - 25 SEX usER %
SGRELATNZ  O/HH MEM - #23 RELATIONTOC..  USER %
g AnEs Q/HH MEM - #35 AGE usER %
Xgsexa 0/HH MEM - 575 SEX UsER % r
SGRELATNZ  O/HH MEM - #3S RELATIONTOC..  USER %
T AGES O/HH MEM - 845 AGE USER %d AAAGregg
g sexs Q/HH MEM - 145 SEX usER %
SGRELATNE  O/HH MEM - #4S RELATIONTOC..  USER %
g AnEs Q/HH MEM - #55 AGE usER %
Tgsexs Q/HH MEM - 5 SEX usER %
_SGRELATNG  O/HHMEM - HSS RELATION TOC..  USER %
e Searchfor [
i & Names " Descriptions
d Regression [ N[





image28.png
Bin Malu
Ani-Mahy

Pl Fie View Data Statistics Graphics Resuits Help
® e

Complted Runs

= Name Desciption

Type

Fomat

Replicated Regression Inputs
Model Speciicaton |

Dependent Varables Independent Varables

Tee

[Frst Repicated Fegresson

[SEGRADES [CBLACK

[HINCOME
TVWKDYNU

Replcation Method: " Jk2 & JKI " BRR " FAY
Replcate Weights
FPWITE
FPVITED
FPWTS - [ Use Constant
Weight [FpviT [Flan Tex Output
oK Cancel

et FINAL PFIINTY WEIGHT, REPLEE  USER P
et FINAL PFIINTY WEIGHT, REPLES  USER P
et FINAL PFIINTYWEIGHT, REPLZD  USER P
et FINAL PFIINTYWEIGHT, REPL7I  USER P
e i FINALPFIINTVWEIGHT REPLZ2  USER %1
Firefox Lo FINAL PFIINTV WEIGHT REPLTS  USER
et FINAL PFIINTYWEIGHT, REPLZA  USER P
— et FINAL PFIINTY WEIGHT, REPLTS  USER P
> & FINAL PFIINTY WEIGHT, REPL7E  USER K
17) i FINAL PFIINTY WEIGHT, REPLT?  USER %
S55E) i | FINALPAIINTVWEIGHT REPL7E  USER %
e FINAL PFIINTYWEIGHT, REPLZS  USER P
et FINAL PFIINTY WEIGHT, REPLBD  USER P
SgPrsu PSU FOR TAYLOR SERIES VAR ES.. USER P
SGPSTRATUM  STRATUM FOR TAYLOR SERIES V.. USER %
SGAGFAS  IMPLTATION FLAG usER %
Glisites Gl T SEF IMPUTATION FLAG USER %d
| xGRESPAGF  IMPUTATION FLAG UsER %
SGRESRELF  IMPUTATION FLAG usER %
SGMOMAGFT  IMPUTATION FLAG usER %
S gwvan IMPUTATION FLAG usER
MOMIYPF2  IMPUTATION FLAG USER %
g SEDADAGFI  IMPLTATION FLAG USER %
SEDADTYPFT  IMPUTATION FLAG usER %
- SgAGF! IMPUTATION FLAG usER %
gsert IMPUTATION FLAG usER %
= gamm IMPUTATION FLAG usER
g AGF2 IMPUTATION FLAG USER %
e SGREATR.  MPUTATION FLAG veR
 XgeF IMPUTATION FLAG usER %
Do N
Searchfor.  [TVWKDYNU
| i & Names © Descriptions
For Help, press FL

)

oRoR

Uni ProblemERVomen I
ity M.

©. 2@l o Q|





image29.png
5 | Observations: 750

6 } Using 80 replicate weights

7 | Estimates centered on overall weight:FINAL PFI INTV WEIGHT
5}

5 IAdjusted Wald Test

10373

11 }p(F > f) = 1.80771e-005.

12 }Dependent Variable: PH2-CHILD'S GRADES ACROSS ALL SUBJECTS
13 [R-Square = 0.168

14 {Parameter Name

15 Constant

16 IPRA-CHILD IS BLACK OR AFRICAN AMERICAN

17 }PUSOV2-TOTAL HH INCOME RANGE

18 IPN17-HW MANY HRS CHILD WTCH TYP WKDY

19 Root Mean Square Error

20 }AM Statistical Software Beta Version 0.06.04. (c) The American Institutes for Research and Jon Cohen

AMOut - Microsoft Excel - @ =
Pagelayout  Formulas  Data  Review  View  Developer  Acrobat c@o@
= Semset- X -
T nen - EPICIE AT
oo g 2T B
< $ - % s | %39 Condtional Fomat Cel Sorta Find &
B8 e sois | [EFomat- | 2+ Fis Sheas
5 Alignment 5 Number 5 stes celts Editing
AL - < | Replicated Regression: First Replicated Regression v
F T
. =
2 !Run completed on Saturday February 09 2013.12:07:32PM
3
4 iselection: AL

78) =9.60401
Estimate  Standard Error tStatistic p> [t}
1995 03 63 o
02 02 108 0275
003 oos  asss o
0.105 0062 169 0093
0.664 - - I~ }

v Amouts /%

ugl ) ]

Select destination and press ENTER or choose Paste





image1.png
[SE=]

65. & > Computer

Organize v

» Local Disk ()

+[%s][ Search Loc.. P

Includeinlibrary v Sharewith v Bum  Newfolder - 3 e
nl Name - Date modified Type Size. e

{18 Downloads E ype
7 Dropbox @
. ErTT 122013343 PM Fil folder
5 Recent Places

U del 9302010133 PM  Fil folder

)l Be2b08Ta3bbedfTc2684116 33072012055 AM  Fil folder

)l 762003560622ld8T8Ac3432 928/2011945 M Fil folder

el

9/28/2010253 PM

File folder





image2.png
e |

Inbos (214) - gbell@cbaua.edu - Col | ] AM SttisticalSftware
« a aivorg

Most Visted '} Geting Sarted () Lotest Headines & Tt [ M caA

what 1s AM? Features

AM is a statistical software AM offers sophisticated statistics

- am software

al ;

support

We have taken great care to ensure





